Taylor Hobson
Aspherics Analysis Utility
Release Notes
Version: 4.7.2, February 2016

Installing and Upgrading Information
Please uninstall the previous version and then install this version using AsphericsAnalysisUtilityDeployment32.msi on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

Windows 7 & 8
This software release is tested and compatible with Window 7 and 8 OS (32-bit and 64-bit). Windows XP is not supported by this or later version.

Licence Code
The following licences are available:

K501/3223
Standard Aspherics Analysis
K501/3224
Astigmatism Analysis
K501/3225
SAG Table Generation
K501/3226
Derived Aspheric Coefficients
K501/3227
Standard Asphero-Diffractive Analysis
K501/3228
Derived  Asphero-Diffractive Analysis
112/4507
Error Compensation
112/4501
Advanced Algorithms
112/4389
Data Correct Analysis


New Features 

AAU-299
Calculate “Tilt” angle from a diffractive analysis


AAU-288
Settings: Sphere should not be required as a specific option but implied from other settings
   AAUU-301
Data Correct profile export (.cor)
AAU-300
Data correct analysis including filtering, left/right, fitting, edge extension, etc.
AAU-307
Data Correct Analysis: Edge extension
AAU-313
A new licence option for Data correct analysis


Improvements

AAU-304
Add Save Data correct tool button
AAU-305
Auto set to zero rather than error message for R-start and R-end in Data correct analysis
AAU-306
Save data correct file automatically by the command file
AAU-311
Satisloh Data correct analysis feed back

Bug Fixes

AAU-312
Timed licence not correctly detected



Version: 4.7.1, February 2015

Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

New Features

AAU-297
Language Support: Japanese, Chinese



Version: 4.6.1, November 2014

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

New Features

AAU-240
Automatic spike removal
Ability to define a spike (height X the rms) and the width (user entered width or smaller) and apply smooth shape or mean.


AAU-199
Best-fit radius and Irregularity(P-V and RMS)
Ability to enter a nominal radius and radius tolerance. Then calculate either the best fit radius for minimum PV or RMS irregularity within the radius tolerance. 
Radius tolerance can be entered as: absolute value (i.e. 100.100mm max 99.900 min) .
Or +- relative value (i.e. +- 0.100mm) or +- % of nominal radius (+- 0.1%). 
This is for both single trace and astigmatism multi-trace data.



Improvements

AAU-279
Command line extensions for automatic reverse fit analysis
X-offset value and tool radius error value are stored in a log file. The file name is AAULastData.log.
A command line option now exists to do reverse fit. 

AAU-290
Update Matlab to 2014a

AAU-292
“Best Fit Radius” to be a licensed analysis type(“Advanced algorithm”)
Available as part of Advanced algorithm license option

AAU-289
Provide access to licensing directly from the AAU menu rather than having to go through Help
Use menu “Help->Licence”

AAU-284
Timed licence information - in About dialog

Licence dialog now has details of expired licences.

Bug Fixes

AAU-286
AAU not adjusting X start position when importing prf3 file

X Start is now obtained from prf3 file 

Version: 4.3.1, November 2013

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

New Features

AAU-281
Command line extension for /nomessage switch
Add the switch /nomessage.

Disable display of any Error and warning messages. And write these messages into “AAUCommandError.txt”.
If the switch “/datalog” exists, then “AAUCommandError.txt” will be created in the same folder as the data log file.
If the switch “/datalog” doesn’t exist, then “AAUCommandError.txt” will be created in the same folder as the AsphericsAnalysisUtility.exe file.

AAU-277
Support more automatic analysis types from command line mode 
/auto <Analysis Type>
<Analysis Type> is one of:
asphericsstandard
asphericsderived
asphericssag
errorcompensation
diffractivestandard
diffractivederived

1. asphericsstandard: Standard aspherics analysis;
2. asphericsderived: Derived aspherics analysis;
3. asphericssag: Aspherics SAG analysis;
4. errorcompensation: Aspherics Error compensation analysis;
5. diffractivestandard: Standard Asphero-Diffractive analysis;
6. diffractivederived: Derived Standard Asphero-Diffractive analysis;
AAU-269
Output the latest parameter results in a log file
A new data file named "AAULastData.log" will be created in the same folder as the AAU log file when the user saves a AAU log file.


Improvements and Bug Fixes

AAU-274
Ability to analyse spherical data
Spherical analysis more stable;
Add colour lables in astigmatism analysis printing;


Version: 4.2.4, February 2013

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

New Features

AAU-252
Error Compensation
Introduce Error Compensation (XOffset error and tool tip radius).
This is available for standard aspherics and can be applied with a form type is spherical (no aspheric axis).

License Option : (112/4507) Error Compensation
AAU-232
Increase number of terms for aspheric analysis from 20 to 40

License Option: (112/4501) Advanced Algorithms

AAU-254
Demo licence for all features, expires 31 March


Improvements and Bug Fixes

AAU-259
Add a command line option to close all loaded data and analyses
/close switch is now available for current analysis.
AAU-250
Memory not released after each analysis is closed-so after many analyses with AAU open the AAU must be restarted.
AAU-249
Unable to read modified profile saved from the AAU with 40 terms

AAU-248
Asphero-diffractive analysis failed – Remove matlab runtime check from the error message

AAU-246
Incorrect diffractive parameter conversion.
 
AAU-238
Would like to apply the filter and Slope error capability to the Diffractive analysis

Parameters are Slope Max (PT), Slope RMS, and Slope Max (X position).
The Filter is the same as the Lambda S cutoff (low pass) filter found in the aspheric form tab.
AAU-234
Add a quick way to close multiple results windows/tabs

"Close All" menu item is under "File" menu.
AAU-200
Separate units for lateral, height, slope

Slope Units including: uInch/Inch, um/mm, Radian, mRadians, uRadians,Deg,min, sec. Done via drop down selector in main menu bar

AAU-196 
The unit change of lambda S filter should links to the lateral scale unit not height units



Version: 4.2.2, June 2012

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

New Features

-


Improvements and Bug Fixes

AAU-237
Timed licence does not work properly with AAU 
Licence support now updated.

Known Issues

Em1324
When doing an asphero-diffractive analysis the AAU keeps showing a warning message saying that “Could not do Asphero-Diffractive analysis. Please check MatLab Runtime installed and latest version; ... etc." 

If you already have MatLab installed then this issue may be caused by a MatLab runtime installation failure. It can be resolved by doing the following:
1.	Open “System Properties” dialog from “Control Panel -> System”;
2.	Open “Environment Variables” dialog by clicking “Environment Variables...” button under “Advanced” tab;
3.	Select the "Path" item in the System variables list, then "Edit...".
4.	In the "Variable value" edit box delete the portion of the string that says “C:\Program Files\MATLAB\MATLAB Compiler Runtime\v714\runtime\win32”.
5.	Uninstall “MatLab Compiler Runtime 7.14” from Control Panel, Add or Remove Programs.
6.	Reinstall MatLab installer from the AAU installation CD.



Version: 4.2.1, May 2012

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

This is not a free of charge upgrade and you will need to contact Taylor Hobson to get a replacement licence.

New Features

AAU-232
Increase number of terms for aspheric analysis from 20 to 40

After installation, AAU is 20 terms version(default);
Please contact Taylor Hobson to find out how to use 40 terms.

Improvements and Bug Fixes

AAU-215
Diffractive analysis zones need to be removed from the saved .mod file
AAU-223
Clear aperture function not working properly for asymmetric data
Improvements have been made to the positioning of the clear aperture area for asymmetric data.
AAU-228
Support for W7 x64 OS
AAU-229
Saving a .mod file results in the assessment length being set to 0.000000 and removes the form aspheric text


Version: 4.1.6, September 2011

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

This is not a free of charge upgrade and you will need to contact Taylor Hobson to get a replacement licence.


Improvements and Bug Fixes

AAU-233
Clear aperture is now symmetrical about aspheric axis if curtains are used to reduce profile width
AAU-214
The diffractive analysis fails to correctly analyse a diffractive if there is a spike in the centre of the part that’s larger than the step height

AAU-207
Latest 2011 TH Logo are used



Version: 4.1.5, May 2011

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

This is not a free of charge upgrade and you will need to contact Taylor Hobson to get a replacement licence.

New Features

AAU-97
Asphero-diffractives – Derived Aspheric Coefficients


Improvements and Bug Fixes

AAU-197
Increase precision on slope parameters display to 4dp

AAU-213
Allow save .MOD file for astigmatism results



Version: 4.1.4, October 2010

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

This is not a free of charge upgrade and you will need to contact Taylor Hobson to get a replacement licence.

New Features

AAU-189
Improved start up time for first MatLab based analysis
1)A reminder will pop up if the right MatLab runtime is not installed;
2)Load MatLab runtime during AAU start up;

Improvements and Bug Fixes

AAU-188
AAU License codes need to be update in the display License dialog as K501... rather than 112...
TH Feature Set application: 
K501-3223-01 Standard Aspherics package (with basic license) 
K501-3224-01 Astigmatism license 
K501-3225-01 SAG table generation license 
K501-3226-01 Derived Aspheric Coefficients license 
K501-3227-01 Asphero-Diffractive license 
K501-3228-01 Derived Asphero-Diffractive Coefficients license
AAU-214
Diffractive analysis fails to correctly analyse a diffractive if there is a ‘spike’ in the centre of the part that’s larger than the step height


Version: 4.1.3, October 2010

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

This is not a free of charge upgrade and you will need to contact Taylor Hobson to get a replacement licence.

New Features

AAU-182 
Support Windows 7 operating system
Default installation folder: c:\Taylor Hobson\Aspherics Analysis Utility;
Demo files folder, Log file folder and Info file folder is: c:\Taylor Hobson\Aspherics Analysis Utility;
Newer MatLab runtime 7.13 is required if using asphero-diffractive analysis;

Improvements and Bug Fixes

AAU-180
Diffractive Analysis - Refractive Index value and Wavelength repeated
1. Change Label "Lamda" to "Wavelength" in Zemax format;
2. Polynomial Type is Zemax, disable "Refractive" and "Wavelength" in Zone Height control if UGDP is checked;
Any changes of "Refractive" and "Wavelength" will pass to Zone Height control.
3. Polynomial Type is Code V, disable "Refractive" in Zone Height control if UGDP is checked;
Any changes of "Refractive" will pass to Zone Height control.
AAU-183
Cof file read failed silently and autoscale exclusion doesn't serialize in the settings file
1. Cof file read failure has been fixed.
2. Autoscale exclusion can now be saved in the settings file;


Version: 4.1.2, August 2010

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.
If you are performing Asphero-diffractive analyses then please also install the MatLab runtime from the CD.

This is not a free of charge upgrade and you will need to contact Taylor Hobson to get a replacement licence.

New Features

AAU-109
Allow user to optionally enter part information (part number etc.) which will appear on the print

Part information (e.g. lens information) for the current analysis can be entered in the new ‘Results’ menu. The information entered will appear only on prints of the results.

AAU-99
New License scheme for v4.
This includes license options for Standard Asphero-diffractive analysis. 112/4199 must be purchased, and then any combination of the additional options:

112/4199  Standard Aspheric Analysis (same as level 1 in the previous license scheme)
112/4200  Astigmatism Analysis
112/4201  SAG Table Generation
112/4202  Derived Aspheric Coefficients
112/4203  Standard Asphero-Diffractive Analysis
112/4219  Derived Asphero-Diffractive Analysis


Standard Asphero-Diffractives analysis
This release makes available Standard Aspheric-Diffractive Analysis. Providing a relevant license has been installed the analysis type choices will include standard asphero-diffractive analysis.
The standard asphero-diffractive analysis requires aspheric and diffractive design data and will calculate a residual profile and parameters and parameters for each zone. 

Improvements and Bug Fixes

AAU-110
A PRF can now be opened in locales other than English
AAU-113
Reading in a read-only profile and saving it as a new raw profile keeps the read-only attribute.
The new file is no longer read-only.
AAU-118
Asphero-diffractive  - Saving the analysis
The user can  the complete asphero-diffractive analysis both manually within the AAU and via the Ultra Command Line

AAU-140
New solution for Radius Optimisation
1. Remove "Radius Optimisation settings" tab which is currently at the bottom of the 'Settings' tab. 
2. Make SAG option always available under Aspherics analysis; no need to have already done an analysis.
3. Add an Optimisd Radius composite User control in "Conic Form settings" tab, which allows the user to tick check box and displays read only optimised radius;
4. Above control only be available for anlaysis of: "Standard"; "SAG"; "Aspherics diffractive".
5.The optimised value will appear in print page's settings (Raw, Form Error and Optimised Form Error) if Radius Optimisation is enabled and not if it is disabled.
6.If Optimised radius has been selected during a SAG analysis, the SAG table is calculated on the optimised radius.
AAU-145
Slope Measurement
New slope parameters are available 


Version: 3.1.2, September 2009

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.

If you are upgrading from a version prior to 3.0.1 then you will need to contact Taylor Hobson to get a replacement licence.

New Features

Ref
Summary
AAU-73
Tool bar icons replace menus
Tool bar icons replace the menu options for adding and removing exclusions
A tool tip for each icon is available.
AAU-74
Undo function
An undo toolbar button is now available to undo the last change to the radius, conic constant and aspheric coefficient.
AAU-86
Command batch file
All command line switches can be grouped together into a single command file. This reduces the amount of information that needs to be specified on the command line, such as from Ultra. Additionally a command file be loaded directly from the File menu – which is helpful for testing the content of the file and for performing a repeated analysis involving various coefficient and settings files. See the help for further information.
AAU-87
Slope Error
The maximum slope error across the form error profile is now calculated. This requires a band width. Further details are available in the help.
AAU-104
“Save Raw Profile”
The ability to save the raw profile (copy the existing raw profile) has been added to the file menu. This provides the user with the opportunity to save the current raw profile to a new named file which is helpful if the same raw profile file name is always being supplied to the AAU (e.g. from an Ultra measurement program).

Improvements and Bug Fixes

Ref
Summary
AAU-11
Opening different file types – merge options to open PRF and MOD files
The options for PRF and MOD files are now merged into one file open dialog.
AAU-29
Multiple error messages from analysis
A single error message is now displayed rather than multiple messages
AAU-42
After opening a data file the path is now remembered so the path can be reused when next attempting to open a file
AAU-56
The “Save as type” option has been removed from the dialog displayed during saving of a modified profile.
AAU-66
Sample files and batch files
Some example files are now provided to help demonstrate the use of the command line switches.
AAU-72
Result layout improvements
The layout of the graphs and presentation of the results has been improved.
AAU-73
Toolbar buttons replace menu items
Addition and removal of exclusions is now done through toolbar buttons rather than menu items.
AAU-76
Zoom out to see whole of the profile
A ‘Reset curtains’ button is now available on the toolbar. When selected the curtains are reset to the extremes of the profile.
AAU-85
The top of the graph should display "Reanalysis Required" when a setting has been changed
A change to any settings, including exclusions will show “Reanalysis required” at the top of the form error graph. This indicates it is necessary to perform an analysis to update the graph and parameter table.
AAU-100
“Manual Scaling” and “Clear Aperture” entry are split into separate tabs
This makes it possible to change the manual Z scaling without causing a re-analysis.
AAU-110
With a German OS the application fails to load a PRF file 
The application can now load a PRF file independent of the OS language or locale.


Version: 3.1.1, June 2009

Upgrading Information
Please uninstall the previous version and then install this version using setup.exe on the CD.

If you are upgrading from a version prior to 3.0.1 then you will need to contact Taylor Hobson to get a replacement licence.

New Features

Ref
Summary
AAU-2
Splash screen switches on/off and AAU single instance
When the AAU is called from the command line only a single instance is opened which therefore removes delays due to start up.
The splash screen can be turned off via a command line switch.
See the help for details on command line switches.
AAU-9
New "settings" file to store AAU settings 
A settings file can be saved and loaded which contains the following information:
	Ls filter

The required vertical scale (if none is selected, the scale would be set automatically)
The required clear aperture (this would take precedence over any clear aperture setting held in the component's COF file)
User exclusion positions (for example if the component has an obvious dislocation, such as an LED lens mold)
Whether to use the design base radius or optimized base radius for analysis
The number of points in the output file.
AAU-17
MRU List 
A list of the most recently opened files is available in the ‘File’ menu.
AAU-22
Automatic File Naming Protocol for Ouput Data (same name as input or prompt user)
Via the command line it is possible to config the name of the output file so that:
(a) It automatically use the same filename as the input profile
(b) The user is prompted for name of the output file and the path can be set
(c) Data is not automatically saved
See the help for details on command line switches.
AAU-23
Manually Loading New Files - persist settings from previous analysis
When manually opening new MOD/PRF files, all user set parameters and design coefficients (including base radius and conic constant) persist from the previous analysis. This enables multiple measurements to be analyzed without having to reload settings / COF files
AAU-45
Data Logging capability for standard analysis - export of parameter results
The parameter values from a standard analysis can be exported to an MS Excel compatible file. A new option exists in the File menu to do this manually, or automatically via a command line switch.
The output file will contain a header and then a row for each export of parameters and their settings. 
See the help for details on command line switches.
AAU-46
Interactive display for a check of input coefficients  (Output Z for given X)
A simple display of the ‘Z’ for a given ‘X’ value to check design coefficients is available in the ‘Equation’ tab. 
AAU-51
Settings file includes number of modified profile data points
The value selected by the user 500, 1000 etc is now stored in the settings file.



Improvements and Bug Fixes

Ref
Summary
AAU-8
The settings files ‘.COF’ and ‘.DCOF’ store the clear aperture
The clear aperture value is now saved in the .COF and .DCOF files.
AAU-10
Loading the "settings" file via the Ultra command line during an AAU spawn batch file
The settings file can be specified on the command line.
See the help for details on command line switches.
AAU-12
Parameter Settings (Manual): The input value is not valid without pressing "return"
AAU-13
Scientific Notation: 7 digital precision rather than 5 digital precision
This is now used for all coefficients. The conic constant is displayed to 7 significant figures.
AAU-14
The scientific notation for all variable needs to be corrected
All values displayed with scientific notation now just have a single digit in front of the decimal point.
AAU-15
Print Format: The basic printout page is untidy
Improved presentation of the printed results. Including logo and display of the path of the design file
AAU-16
Providing Admin rights: Adding admin rights to lock all designs and settings
Start AAU from the command line using the admin option will lock the UI so that the user cannot change and settings. They will still be able to manually set exclusion regions.
See the help for details on command line switches.
AAU-19
Path of COF file is now displayed on print out when AAU is run via ADF spawned from the command line

AAU-21
Update of User Help

AAU-34
‘Add & remove’ program properties file version is now correct
AAU-37
Coefficients in inches are now in correct exponential scientific notation
AAU-40
Appropriate number of decimal places in inches in an astigmatism analysis
The Z axis scale is now scaled appropriately.
AAU-49
Default colour scheme for astigmatism profile prints improved
The default profile colours are now easily viewable for blank and white prints whereas previously they could be too faint.
AAU-31
Installation - dependency on .NET 3.5 SP1
Installation improved as the installation now only depends on .NET 3.5 which can be obtained from the CD.
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